
CHAPTER1
GETTING STARTED AND GETTING
AROUND

F E A T U R I N G

� Starting Access

� Opening and closing a database

� Working in the Database window

� Getting help when you need it
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m
icrosoft Access is a database management system, or DBMS. As the
name implies, a DBMS helps you to manage data that’s stored in a
computer database. The data you manage can be virtually anything,
including:

• Names and addresses

• Business contacts, customers, and sales prospects

• Employee and personnel information

• Inventory

• Invoices, payments, and bookkeeping

• Libraries and collections

• Schedules, reservations, and projects

You may already know what kinds of data you plan to manage with Access, and
you may already be familiar with other database programs and the basic concepts of
database management. If not, you’ll learn more about databases in the next chapter.
But whether you’re a seasoned veteran eager to start working in Access, or a database
newcomer wondering where to begin, the first step is to learn how to start Access and
use its extensive Help system to coach you along as you work.

Access Isn’t Just for Techies!
Don’t worry if you know nothing about databases and don’t want to become an expert
on the topic. Access wizards can guide you through almost any step, and they can cre-
ate databases for you automatically. So even if you need to set up something as com-
plex as a system for managing orders, inventory, or assets—or something as simple as
a list of contacts and birthdays—Access wizards can take care of the grunt work while
you focus on getting useful information from your computer. You’ll have a chance to try
wizards during the hands-on tour in Chapter 3 and in many other chapters of this book.

If you’re a technical type, never fear! Access has more than enough to make you happy.
It’s a full-featured application development system that includes the Visual Basic pro-
gramming language and other tools for setting up sophisticated applications for your-
self and your customers. You’ll learn more about these features in Parts Four and Five.
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Starting Access
To start Microsoft Access:

1. Start Windows in the usual manner.

TIP If you’re using Microsoft Office and have added Access to the Microsoft Office
Shortcut Bar, you can start Access by clicking the appropriate button on the Office Shortcut
Bar (see Chapter 4). Or if you’ve set up a shortcut icon for Access on the Windows Desk-
top, you can double-click that icon to start Access. Then skip to step 3 below.

2. Click the Start button on the Windows Taskbar and then choose Programs �
Microsoft Access 2002.

After a short delay, you’ll normally see the Microsoft Access New File task pane
shown in Figure 1.1. If you’ve just installed Access, the list below Open a File is
empty.

FIGURE 1.1
The Microsoft Access
New File task pane.
From here you can
create a new data-

base, a data access
page, or a project. You
can also open an exist-

ing file, start the Add
Web Folder Wizard, or

get Help.
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CHAPTER 1 • Getting Started and Getting Around6

3. Do any of the following:

• To create a new blank database, choose Blank Database under New.

• To create a new database using a template, click General Templates
under New From Template and then click the Databases tab in the Tem-
plates window. Double-click your choice, and name the new file to start the
Database Wizard. (There’s more about creating new databases in Chapter 5.)

• To create a data access page or a project, choose Blank Data Access
Page, Project (Existing Data), or Project (New Data) under New. Refer to
Chapter 14 for details on working with data access pages, or Chapter 30 for
projects. (You’ll learn more about the difference between databases and pro-
jects later in this chapter.)

• To create a new file that’s a copy of a file you already have, click
Choose File under New From Existing File. 

• To open an existing database or project, click its name under Open A
File, or click More Files so you can look for it using the Open dialog box. See
“Opening an Existing Database or Project” later in this chapter for more
details on how to do this.

• To go to the main Microsoft Access window (shown in Figure 1.2)
without creating or opening a database, click the Close button (X) in the
upper-right corner of the New File task pane.

FIGURE 1.2
The main Microsoft
Access window as it

appears when there is
no file or task 

pane open.
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NOTE If Access is customized to bypass the New File task pane, you’ll be taken to the
main Access window as soon as you finish step 2, above. We explain how to start Access
without opening the New File task pane later in this chapter.

Advanced users can learn about optional command-line startup switches for Access
in Chapter 16 and by searching the Access Help index: on the Index tab of the Access
Help window first enter startup in the keyword box and click Search; then double-
click Startup command-line options on the topic list. We’ll explain how to use Access
Help in the “Getting Help” section later in this chapter.

Organizing the Start � Programs Menu Items
If your Start � Programs menu has too many entries or isn’t organized the way you like,
you can rearrange it easily. Suppose you want to move Microsoft Access and other
Microsoft Office programs from the main Start � Programs menu into a Microsoft Office
submenu that looks something like the image below.

All it takes is a little knowledge of Windows Explorer and these basic steps:

1. Right-click the Start button on the Taskbar and choose Explore.

Starting Access
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CHAPTER 1 • Getting Started and Getting Around8

2. Click the Programs folder in the left pane of the Exploring window. (It’s below the
Start Menu folder.) The right pane will show the contents of the Programs folder.

3. Right-click your mouse on an empty part of the right pane of the Exploring window
and choose New � Folder from the shortcut menu.

4. Type a new folder name, such as Microsoft Office, and press Enter.

5. Click the + sign next to the Programs folder in the left pane; then use the vertical
scroll bar to scroll the left pane until you can see the new folder you created and
named in steps 3 and 4.

6. Drag the program (or folder) you want to move from the right pane to your new
folder in the left pane.

7. Repeat step 6 as needed and then click the Close button in the Exploring window.

For more details on customizing the Start menu, choose Start � Help, and click the
Index tab. Type Start Menu and, on the list of related topics, double-click reorganizing
items on. To learn more about Windows Explorer, look up topics below Windows
Explorer on the Index tab in Help.

Creating a Desktop Shortcut
You can double-click a shortcut icon on the Windows Desktop to launch a program or
open a file. To quickly add an icon that will launch the Access program from the
Desktop, minimize or close any open windows and then follow these steps:

1. Use Windows Explorer to open the folder that contains Microsoft Access. For example,
right-click the Start button on the Windows Taskbar, choose Explore, and navigate to
the Program Files\Microsoft Office\Office XP folder. (It’s usually on drive C.)

2. On the right side of the Explorer window, locate the Msaccess program icon. It will
appear as a key next to the program name, msaccess.exe.

3. Hold down the right mouse button while you drag the icon to the Windows Desk-
top. Release the mouse button.

4. Choose Create Shortcut(s) Here from the shortcut menu.

In the future, you can start Access by double-clicking the Shortcut to Msaccess.exe icon
on your Desktop. To discover other ways to create shortcuts for Access, look up the
Shortcuts topics in the Access Help index or the Windows Help index. (To get Windows
Help, click the Start button on the Taskbar and choose Help.)
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Opening an Existing Database or Project
In word processing programs, you work with documents. In spreadsheet programs,
you work with worksheets. In database management systems, such as Access, you
work with databases. Eventually you’ll want to create your own database, but for now
you can get some practice by exploring one of the sample databases that comes with
Access.

NOTE In Access, you can also work with projects stored in .adp files. A project holds
tools like forms and reports for working with SQL Server data. See “And What about Pro-
jects?” later in this chapter for more information on Access projects and how they are dif-
ferent from Access databases.

To open a database or a project:

1. Do one of the following, depending on whether you’re starting from the New
File task pane, from the main Microsoft Access window, or from the Windows
Desktop:

• From the New File task pane (refer to Figure 1.1), check the list under
Open a File. If the name of the database or project you want to open is
shown on the list, click that name, and you’re done. If the name isn’t on the
list, click More Files and continue with step 2.

• From the main Microsoft Access window (refer to Figure 1.2), choose 
File � Open, click the Open toolbar button (shown at left), or press Ctrl+O.
You’ll see an Open dialog box, similar to the example shown in Figure 1.3.

TIP If you recently used the file you want to work with, try this tip to open it quickly:
Choose File from the menu bar, and look for the file name near the bottom of the File menu
(just above the Exit option). Click its name, or type the number shown next to the name.

• From the Windows Desktop, locate the desired database or project
using standard techniques in Windows Explorer, My Computer, or Network
Neighborhood. When you find the file you want to use, double-click its
name or icon (see the sample icon, shown at left). If you’ve used the file
recently, click the Start button on the Windows Taskbar, choose Documents,
and then click the name of your database in the list that appears. Access will
start, and the database or project will open. You’re done, so you can skip
steps 2 through 4.

Opening an Existing Database or Project
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CHAPTER 1 • Getting Started and Getting Around10

FIGURE 1.3
The Open dialog box.

2. Use any of these methods to find the database or project you want to open:

• To see the files you opened most recently, click the button for History
on the left side of the Open window.

• To show the files in My Documents or on the Desktop without hav-
ing to navigate using the Look In drop-down list, click the My Documents
or Desktop button on the left side of the Open dialog box.

• To open an object shown in the list below Look In, double-click the
appropriate object icon or name.

• To choose the computer, drive, or folder where the database is
stored, click the Look In drop-down list button and then click the appro-
priate item.

• To open the folder that’s just above the currently selected folder,
click the Up One Level button in the Open dialog box, or click anywhere in
the list below Look In and then press Backspace.

TIP To learn the purpose of any toolbar button in a window or dialog box, move your
mouse pointer to that button and look for the ScreenTip near the mouse pointer. See
“Using the Toolbars and Menu Bar” later in this chapter for more information.

4008c01.qxd  5/20/01  5:18 PM  Page 10



11

• To display a list of your favorite databases and folders, click the
Favorites button on the left side of the Open dialog box. The list below Look
In will then show your favorite folders and databases only.

• To add an item to your Favorites list, make sure the appropriate item
appears in the Look In text box or click an item name in the list below Look
In. Choose Add to Favorites from the Tools drop-down list.

• To enter a drive, directory, and/or file name manually, type the
appropriate information into the File Name text box in the lower part of the
Open dialog box, or choose an item from the File Name drop-down list.

• To change the appearance of the list below Look In, click the Views
button and then select List, Details, Properties, or Preview.

• To search for a database or project, click the Tools drop-down list and
then select Search to open a dialog box you can use to hunt for files.

TIP You can delete, rename, and do other handy operations on items from the Open
dialog box. To begin, right-click an item in the list below Look In. Choose an option from
the shortcut menu.

3. If you’re choosing the database or project from the list below Look In, make sure
its name is highlighted on the list. (Click the name, if necessary.)

4. Click the Open button. (As a shortcut for steps 3 and 4, you can double-click a
file name in the list below Look In.)

The database or project will open, and you’ll see the Database window or a form
that either describes the database or lets you work with it.

TIP If the database or project you’re planning to open usually displays a form, but you’d
prefer to bypass that form and go directly to the Database window, hold down the Shift
key while you open the file. This action bypasses the form and any options that are set in
the Startup dialog box (Tools � Startup).

As Figure 1.3 shows, the Open dialog box contains many buttons and special fea-
tures that we haven’t mentioned here. If you’ve played with other Open dialog boxes
in Microsoft Office or you’ve spent some time with Windows Explorer, you’ll learn
the fine points quickly. One nice new feature of Office XP enables you to resize the
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CHAPTER 1 • Getting Started and Getting Around12

Open and Save dialog boxes. For more guidance, click the ? button in the upper-right
corner of the Open dialog box and then click the part of the dialog box you’re curious
about. Feel free to experiment!

Opening the Sample Northwind Database
To use the Northwind database that comes with Access, you have to make sure it gets
installed. By default, it gets installed on first use, which means the first time you try
to use it, it will be copied from your Office CD to your computer. For this to work,
you have to select Northwind.mdb from the File menu before it is overwritten by other
databases you open after you first install Access.

If you don’t find Northwind.mdb on the bottom of your File menu, run Setup for
Office again, and click Add or Remove Programs. In the window that lets you select
the programs to install, click the Expand button for Microsoft Access for Windows.
Expand Sample Databases, change the setting for Northwind Database from Installed
on First Use to Run from My Computer, and click Update. Once the Northwind data-
base is installed, you can open it this way:

1. Click the New button on the toolbar to open the New File task pane (if it’s not
already open), and click More Files.

Or

Choose File � Open from the main Microsoft Access window to show the Open
dialog box.

2. Using the Look In drop-down list, navigate to the folder C:\Program Files\
Microsoft Office\OfficeXP\Samples.

3. Double-click Northwind.mdb in the list of files.

4. Click OK on the Welcome form to open the Main Switchboard for the database.

5. Click the button labeled Display Database Window to explore the objects
included in Northwind.mdb.

Maximizing Your On-Screen Real Estate
The Windows Taskbar can take up valuable on-screen real estate that you might prefer
to make available to your database objects. Fortunately, hiding the Taskbar temporarily
and bringing it into view only when you need to is easy. (Most screen shots in this book
were taken with the Taskbar hidden.)
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To hide the Taskbar temporarily, right-click any empty spot on the Taskbar, choose
Properties, make sure the Always On Top and Auto Hide options in the Taskbar
Properties dialog box are checked, and then click OK. In the future, the Taskbar will
remain hidden until you move your mouse pointer to the edge of the screen where the
Taskbar was lurking the last time you used it. (If you don’t remember where the Taskbar
was, move the mouse pointer to the bottom, top, left, and right edges of the screen
until it pops into view.)

To display the Taskbar permanently again, return to the Taskbar Properties dialog box
and deselect (clear) the Auto Hide option. (It’s usually best to leave Always On Top
checked.) Then click OK.

The objects (a term for database components, such as tables and forms) that are part
of the Northwind database will appear in the Database window (see Figure 1.4). You
can move, size, maximize, minimize, and restore the Database window using all the
standard Windows techniques.

What Is a Database, Anyway?
A widely accepted definition of a database is “a collection of data related to a particu-
lar topic or purpose.” If that sounds a bit stuffy, just think of a database as a general-
purpose container for storing and managing information. The information can be
anything from names and addresses to details about your business’s inventory and
orders.

There’s more to a database than data. A database can also contain objects to help
you manage that data, such as forms (for entering and editing data) and reports (for
printing data in the format you want). All told, a database can contain any combina-
tion of the following types of objects:

Table Tables are the fundamental structures in an Access database because they
store the data you’ll be managing (see Chapter 6). Within a table, data is organized
into fields (columns) and records (rows). When you open a table, it is shown in a
window called a datasheet view.

Query A query is a tool for asking questions about data in your tables and for
performing actions on data (see Chapter 10). Queries can answer questions, such
as: How many customers live in Connecticut, and what are their names and phone
numbers? You can use queries to combine or join data from many separate but
related tables. A query can, for example, join Customers, Orders, Order Details, and

Opening an Existing Database or Project
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CHAPTER 1 • Getting Started and Getting Around14

Products tables to answer the questions: Who ordered left-handed scissors? and
What is the value of those orders? Queries can also help you change, delete, or add
large amounts of data in one fell swoop. Finally, you can use queries as the basis
for your forms and reports.

FIGURE 1.4
The Northwind :

Database window with
Tables selected under

Objects.

Form Forms enable you to display and enter data in a convenient format that
resembles fill-in-the-blank forms (see Chapters 11 and 13). Your forms can be plain
and simple, or quite elaborate with graphics, lines, and automatic lookup features
that make data entry quick and easy. Forms can even include other forms (called
subforms) that let you enter data into several tables at once.

Report Reports let you print or preview data in a useful format (see Chapters 12
and 13). Like forms, reports can be plain or fancy. Examples include mailing labels,
lists, envelopes, form letters, and invoices. Reports also can present query results in

4008c01.qxd  5/20/01  5:18 PM  Page 14



15

an easy-to-understand format. For instance, you can print sales by customer,
receivables aging, and other management information for use in making business
decisions.

Page Data access pages are HTML files that display data in a format that can be
browsed on the Web. Unlike other kinds of database objects, data access pages are
stored in their own .htm files instead of as part of an Access database or project file.

Macro A macro is a set of instructions that automates a task you need to do
often (see Chapter 21). When you run a macro, Access carries out the actions in
the macro in the order in which the actions are listed. Without writing a single
line of program code, you can define macros to automatically open forms, print
mailing labels, process orders, and more. Macros enable you to assemble a collec-
tion of tables, queries, forms, and reports into turnkey applications that anyone can
use, even if they know little or nothing about Access itself.

Module Like macros, modules allow you to automate and customize Access (see
Part V). However, unlike macros, modules give you more precise control over the
actions taken, and they require you to have Visual Basic programming expertise.
You may never need to use modules, so don’t worry if you’re not a programmer.

During the hands-on lessons in Chapter 3, you’ll have a chance to create a data-
base complete with tables, forms, reports, a data access page, queries, and even a simple
form module. You’ll be astounded at how quickly you can do this job when you let
the wizards do all the tough stuff for you.

And What about Projects?
An Access project is a set of database objects that can be used to work with data stored
in tables that are part of a SQL Server database. A project file doesn’t hold any tables
or queries of its own; the only kind of Access objects it includes are forms, reports,
macros, modules, and data access pages. With a project, you can also use views, stored
procedures, and database diagrams that are part of a SQL Server database.

A project can work with data stored on these servers:

• Microsoft SQL Server 2000 on Microsoft Windows 2000 and Microsoft Windows 98
or later

• Microsoft SQL Server 2000 Desktop Engine on Windows 2000 and Windows 98
or later

• Microsoft SQL Server 7.0 on Microsoft Windows NT 4.0 or later (with Microsoft
Windows NT Service Pack 4 or later) and Microsoft Windows 95 or later

And What about Projects?
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CHAPTER 1 • Getting Started and Getting Around16

• Microsoft Data Engine (MSDE) on Windows NT 4.0 or later and Windows 95 or
later

• Microsoft SQL Server 6.5 on Windows NT 4.0 or later (with SQL Server Service
Pack 5 or later)

If you’d like to find out more about working with projects, take a look at Chapter 30.

Working in the Database Window
The Database window is one of your main tools for using Access. When exploring the
sample Northwind database and when creating databases or projects of your own,
you’ll use this simple three-step process to work with the objects listed in the Data-
base window:

1. Choose the type of object you want to create, use, or change using the buttons
in the bar on the left side of the Database window. That is, click Tables, Queries,
Forms, Reports, Pages, Macros, or Modules.

2. If you want to use or change an existing object, click its name in the list of
objects.

3. Do one of the following:

• To create a new object of the type you selected in step 1, click the
New button along the top of the Database window.

• To use (or view or run) the object, click the Open (or Preview or Run)
button.

• To change the object’s appearance or structure, click the Design
button.

TIP As a shortcut for opening (or previewing or running) an object, you can double-
click its name in the Database window.

What happens next depends on the type of object you selected and on the type of
operation you chose in step 3. We’ll say more about the various types of objects in
upcoming chapters.
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Closing an Object
Regardless of how you open an object, you can use any standard Windows technique
to close it. Here are three surefire methods:

• Click the Close (×) button in the upper-right corner of the window you want to
close (not the Close button for the larger Microsoft Access program window).

• Choose File � Close from the Access menu bar.

• Press Ctrl+W or Ctrl+F4.

Some Access windows also display a Close button on the toolbar.
If you’ve changed the object you were viewing, you may be asked if you want to

save those changes. Respond to the prompt accordingly.

Uncovering a Hidden Database Window
Sometimes the Database window will be invisible, even though you’ve opened a data-
base. If that happens, you can return to the Database window (assuming the database
is open) by using any of these techniques:

• Press the F11 key.

• Choose Window � Name: Database from the menu bar (where Name is replaced
by the name of the open database, such as Northwind).

• Click the toolbar’s Database Window button (shown at left).

If none of those methods works, close any other objects that are on the screen and
try again. If you still can’t get to the Database window, you’ve probably closed the
database. To reopen the database, choose File from the Access menu bar and then
click the name of the database near the bottom of the menu. Or use File � Open as
discussed earlier in this chapter.

NOTE When you open some databases, a custom form window, rather than the Data-
base window, will appear. That’s because whoever created that database has turned it into
an application. Even so, pressing F11 usually will take you to the Database window (unless
the application designer has disabled this feature). Often you can bypass the initial form
window and all the other startup options by holding down the Shift key as you open the
database.

Working in the Database Window
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CHAPTER 1 • Getting Started and Getting Around18

Changing Your View of Database Window Objects
You can use options on the View menu, or equivalent buttons on the Database win-
dow toolbar, to change the size of objects and the amount of detail listed for them.
Table 1.1 summarizes these options and buttons. In Figure 1.4, for example, the data-
base objects are shown as a list. To get to this view, if some other view is being used,
click the List button on the toolbar that’s part of the Database window or choose
View � List from the Access menus.

TABLE 1.1 View Menu Opt ions  and Equiva lent  Toolbar  But tons

VIEW MENU OPTION BUTTON DESCRIPTION

Large Icons Shows each object as a large icon with the object name
below the icon. Object names initially appear in rows;
however, you can drag them as needed.

Small Icons Shows each object as a small icon with the object name
next to the icon. Object names initially appear in horizon-
tal rows; however, you can drag them as needed.

List Shows each object as a small icon with the object name
next to the icon. Object names appear vertically, in one or
more columns.

Details Shows each object as a small icon with the object name
next to the icon. Object names appear with one object to
a line and five columns of detail about each object. The
columns list the object’s Name, Description, date/time
Modified, date/time Created, and object Type.

• To resize a column, move your mouse pointer to the
vertical divider that’s just to the right of the column
heading. When the pointer changes to a crosshair, drag
the mouse to the left or right-click or double-click the
divider for a snug fit.

• To sort a column in ascending order, click the appropri-
ate column header button. To sort the column in
descending order, click the column header button
again.

• To add a Description to any object, right-click the object
name in the Database window, choose Properties, type
a description, and then click OK.

Note: You can use the View � Arrange Icons and View � Line Up Icons commands on the menu bar
(or right-click a blank area on the Database window and choose the View � Arrange Icons or View �
Line Up Icons options from the shortcut menus) to rearrange and align icons as needed. (If you don’t
see these choices on the View menu, click the arrows at the bottom of the menu to show more
choices.)
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Working with Groups of Objects
At the bottom of the bar on the left side of the Database window under Groups is an
item called Favorites. This is a place where you can add objects you use frequently,
regardless of their type. When you click the Favorites button, these objects appear in
the Database window together, instead of being separated by type.

Adding Objects to the Favorites Group
If you want to add an object to the Favorites list, first click the button on the Objects
bar for the right type to bring the object into view; then right-click the object, and
select Add to Group � 1 Favorites from the shortcut menu that appears. When you
click the Favorites button under Groups, you’ll see the object you added on the
Favorites list.

Creating a New Group
If you’re working with a complex database that includes many objects, you might
want to group the objects into more than one category. For this reason, Access lets
you create your own groups and add them to the Database window Objects bar. Any
group you add will appear under Groups, along with the Favorites button.

To create a new group, right-click any item under Objects or Groups and choose
Add to Group � New Group from the shortcut menu that appears. Enter a name in
the New Group window, and click OK.

TIP After you add new groups to the Objects bar, there won’t be enough room to dis-
play all the object types. You can use the Show More button just above Groups to bring
them into view, or resize the Database window to make it longer, and drag Groups down
to make more room for the Objects list.

Adding Objects to a New Group
To add an object to a new group, follow the instructions for adding an object to the
Favorites list with this change: Instead of choosing 1 Favorites, select the new group
from the shortcut menu that appears after you select Add to Group.

Deleting a Group
If you don’t need to use a group anymore, you can remove it from the Groups list on
the Objects bar. Just right-click the group’s name under Groups, and choose Delete
Group from the shortcut menu.

Working in the Database Window
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CHAPTER 1 • Getting Started and Getting Around20

Managing Database Objects
The Database window enables you to do much more than just open objects. You also
can use that window to manage the objects in a database—that is, to copy them,
delete them, rename them, and so on. Here’s how:

1. If the object you want to work with is currently open, close it, as described ear-
lier under “Closing an Object.”

2. If you haven’t already done so, choose the type of object you want to work with
(by clicking Tables, Queries, Forms, Reports, Pages, Macros, or Modules in the
Database window). Click the name of an object and then:

• To delete the object, choose Edit � Delete or press Delete; click Yes when
prompted for confirmation. To delete the object and move it to the Win-
dows Clipboard (without being asked for confirmation), hold down the
Shift key while pressing Delete or press Ctrl+X. (Be careful, there’s no undo
for this operation; however, you can paste the object from the Clipboard by
pressing Ctrl+V.)

• To rename the object, click the object name again (or choose Edit �
Rename), type a new name (up to 64 characters, including blank spaces if
you want), and then press Enter.

• To copy the object into this same database, choose Edit � Copy or press
Ctrl+C. Then choose Edit � Paste or press Ctrl+V. Enter a valid object name
(up to 64 characters), choose other options as appropriate, and then click
OK. The copy will appear in the list of objects in its proper alphabetical
position. (You may need to scroll through the object names to find the
copy.) Copying can give you a head start on designing a table, form, report,
or other object that is similar to the object you copied. You can then change
the copied object without affecting the original.

• To create a shortcut icon on the Windows Desktop for the selected
object, choose Edit �Create Shortcut, specify the Location (if you want), and
then click OK. In the future, you can double-click the shortcut icon on the
Windows Desktop to start Access and open the object in one fell swoop.

TIP Another way to create a shortcut to an Access object is to size the Access window
so that you can see Access and the Windows Desktop at the same time. (One way to do
this is to right-click an empty place on the Windows Taskbar and choose Cascade.) If you
want to put the shortcut in a folder, open that folder in Windows Explorer, My Computer,
or Network Neighborhood. Finally, drag and drop the selected Access object to the Desk-
top or folder. You also can drag and drop tables and queries from the Database window to
Microsoft Excel, Microsoft Word, and other program windows (see Chapter 4).
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• To print the object, choose File � Print, press Ctrl+P, or click the Print
toolbar button (shown at left). Click OK from the Print dialog box to print
the entire object.

• To preview the object before printing, choose File � Print Preview or
click the Print Preview toolbar button (shown at left). When you’re done pre-
viewing the object, close it as described earlier under “Closing an Object.”

• To save the object with a new name in the same database, choose
File � Save As.

• To export the object to a Web Page, another Windows program,
or to a different Microsoft Access database, choose File � Export.
Complete the dialog box and click OK.

• To import or link data from another program or database, choose
File � Get External Data and then choose either Import or Link Tables.
Complete the dialog box that appears and then click the Import or Link
button.

TIP Many of the operations described above also are available when you right-click an
object or right-click any gray area on the Database window. See “Opening Shortcut
Menus” later in this chapter for details.

See Chapter 7 for more information about moving and copying objects between data-
bases or about interacting with other programs. Or search the Access Help index for
any of these topics: Exporting Data, Importing Data, and Linking.

Using the Toolbars and Menu Bar
Toolbars offer time-saving shortcuts to commonly used commands. To use the toolbars:

1. Move the mouse pointer to the toolbar button you want to choose.

2. Wait a moment, and a brief description (called a ScreenTip) will appear near the
mouse pointer, as shown below.
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3. Do one of the following, depending on the type of button you’re pointing to
(see Figure 1.5 for examples):

• For a square (normal) button, click the button.

• For a drop-down button, you have two choices. Either click the picture
part of the button to take whatever action the picture shows, or click the
drop-down arrow next to the picture and then choose an option from the
menu or palette that appears.

• For a drop-down list, click the drop-down arrow next to the box and
then choose an option from the list that appears, or click the drop-down
arrow and then type your choice into the text box.

FIGURE 1.5
Examples of square

(normal) buttons,
drop-down buttons,

and drop-down lists on
toolbars.

NOTE If you change your mind about choosing a drop-down button or drop-down list
after you’ve clicked its drop-down arrow, click the drop-down arrow again or click an
empty area outside the toolbar.

TIP If the drop-down button opened a palette, you can drag the palette anywhere on
the screen. After you detach the palette from its button, the palette remains open and
available until you click the Close button on the palette, click the arrow next to the drop-
down button, or close the object you’re working with.
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Viewing Toolbars, ScreenTips, and the Status Bar
Toolbars, ScreenTips, the status bar, and other on-screen features are optional and cus-
tomizable. If you don’t see one of these features in Access, chances are it’s just hidden
(or turned off).

To display (or hide) the status bar or the New File (Startup) task pane (shown in
Figure 1.1):

1. Open any Database window. (The Tools � Options and Tools � Startup com-
mands described below are available only when a database is open.)

2. Choose Tools � Options from the Access menu bar and then click the View tab.

3. Select (check) an option to display (or turn on) the feature; deselect (clear) the
option to hide (or turn off) the feature. For example, select Status bar and
Startup Task Pane to display the status bar and startup task pane shown earlier
in this chapter. Click OK.

To display or hide ScreenTips (the descriptions that appear when you point to a
toolbar button):

1. Choose View � Toolbars � Customize from the Access menu bar and then click
the Options tab.

2. Select (check) Show ScreenTips on Toolbars to show a brief description of what a
toolbar button does when you point to it.

3. Click Close.

You also can customize many startup features for the current database (including
whether the Database window, status bar, and built-in toolbars appear). To do so,
choose Tools � Startup. You’ll see the Startup dialog box shown in Figure 1.6. As
usual, you can select (check) options you want to turn on and deselect (clear) options
you want to turn off. You also can type text into the text boxes and choose options
from the drop-down lists. When you’re finished making changes, click OK. See Chap-
ter 16 for more about personalizing Access.

FIGURE 1.6
This sample Startup

dialog box shows
default options that
work well for most

people. Choose Tools
� Startup to get here.
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NOTE Pressing the Shift key when you open the database will bypass any Startup
options that you’ve changed, giving you the default options shown in Figure 1.6.

Showing More of a Menu
Some of the drop-down lists for Access menu choices, such as Edit, come in two ver-
sions: a short list of the most commonly used commands and a longer list with extra
commands. When you’re viewing the short version of a drop-down list, it will have a
Show More button like the one shown for the Edit menu here:

To see the long version of a menu, click its Show More button, or just leave the
menu open for a few seconds without making a choice. The short version will then
transform into the longer list on its own, if there is one available. The long version of
the Edit menu shown above looks like this:
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Positioning the Toolbar or Menu Bar
By default, the toolbar is docked just below the menu bar (refer to Figure 1.4). You can
convert the toolbar to a free-floating element or dock it to some other edge of the
screen. You can also move the menu bar or dock it in a new location. Follow these
steps to move the menu bar or a toolbar:

1. Move the mouse pointer to the handle on the left side of the toolbar.

2. Drag the menu bar or toolbar toward the center of the screen to make it free-
floating (see the example below), or drag it to some other edge of the screen to
dock it there. To restore a floating menu bar or toolbar to its previous docked
position, double-click its title bar.

When the toolbar is floating freely, you can drag it by its title bar to any place on
the screen. Here are some other toolbar tips:

• To close (hide) the floating toolbar, click the Close button on the toolbar’s
upper-right corner or right-click any toolbar and click the toolbar’s name in the
shortcut menu that appears. (Shortcut menus are discussed in the next section.)

• To redisplay a hidden toolbar, choose View � Toolbars, click the check box
next to the toolbar you want to view, and then click the Close button in the
Toolbars dialog box.

• To redisplay a default toolbar for the current view, right-click any visible
toolbar and then click the toolbar’s name in the shortcut menu that appears.

If the redisplay procedures above don’t work, choose Tools � Startup, select (check)
Allow Built-In Toolbars, and then click OK. Close the database and then open it again.
If necessary, choose View � Toolbars to redisplay the toolbar.

NOTE If you manually show a built-in toolbar, it will appear in every view. If you hide a
built-in toolbar from within its default view, it will be hidden in every view (including its
default view).

We discuss many other ways to use and customize the toolbars in Chapter 24. But
for now, just knowing how to hide, display, and position the toolbar is enough. If you
do need a quick reminder or more information on toolbars, use the Office Assistant to
find help for Toolbars.

Using the Toolbars and Menu Bar
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Opening Shortcut Menus
Access provides many shortcut menus to save you the trouble of looking for options on
the menu bars and toolbars. Shortcut menus in the Open and Save dialog boxes also
offer handy ways to manage your files and folders without leaving Access.

To open a shortcut menu that’s tailored to whatever you want to work with, right-
click the object or place you’re interested in, or click the object and then press
Shift+F10. For example, right-clicking a table name in the Database window opens
this menu:

NOTE If the shortcut menus don’t appear when you right-click, choose Tools �
Startup, select (check) Allow Default Shortcut Menus, and click OK. Then close and open
the database again.
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To select an option from the menu, do one of the following:

• Click the option with either the left (primary) or right (secondary) mouse 
button.

• Type the option’s underlined letter, or point to the option with your mouse and
then press Enter. If two options share the same underlined letter, press the letter
repeatedly to cycle through all the matching options.

To close the menu without selecting an option, press Esc, Alt, or F10—or click out-
side the menu.

TIP The term right-click means to point at something with your mouse pointer and
then click the right (secondary) mouse button. (If your mouse is set up for lefties, you’ll
have to click the left mouse button instead.) This right-click trick is available throughout
Access (and, indeed, throughout Windows). As you work with Windows and Access, be sure
to experiment with right-clicking. It is a great way to discover some truly useful shortcuts.

Closing a Database or a Project
When you’re done working with a database or a project, you should close it. Any of
these methods will work:

• Click the Close button in the upper-right corner of the Database window.

• Go to the Database window and then choose File � Close from the Access
menu bar.

• Press Ctrl+W or Ctrl+F4.

As usual, you’ll be prompted to save any unsaved work.

NOTE You can have only one database open at a time. Access will automatically close
the currently open database if you choose File � Open or File � New before closing the
database or project that’s open.

Getting Help
One thing we hope to teach you in this book is how to get answers to questions—
even if we haven’t provided those answers. You can achieve this goal easily if you
learn how to use Access’s plentiful built-in Help. We’ll show you how to use this self-
help tool next.
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Summary of Self-Help Techniques
Table 1.2 summarizes many ways to get and use online Help in Access. Remember
that you can use all of the standard Windows techniques while you’re in the Help sys-
tem to annotate Help, print a topic, change fonts, and so forth. For more information
on those topics, see your Windows documentation or the Windows online Help. You
can experiment by right-clicking in any Help text window and choosing options from
the shortcut menu.

TABLE 1.2 Microsof t  Access  2000 Onl ine Help Opt ions  and Techniques

Type of Help How to Get It

Ask a Question box Type your question in the box on the right side of the
Access menu bar.

Office Assistant If the Office Assistant is activated, choose Help �
Microsoft Access Help, or click the Microsoft Access Help
button on the toolbar. If the Office Assistant is not acti-
vated, choose Help � Show Office Assistant to open the
Assistant and activate it.

Table of Contents Choose Help � Microsoft Office Help, click the Office
Assistant’s Search button if the Office Assistant appears,
and click the Contents tab in the Help dialog box. If the
Contents tab isn’t visible, click the Show button first.

Search Help Click the Index tab in the Help dialog box.

Find Help on the Web Choose Help � Office on the Web.

Display a Minimized Help Window Click the ? Microsoft Access Help button on the
Windows Taskbar.

What’s This…? Choose Help � What’s This?, press Shift+F1, or click the
? button on the toolbar or at the upper-right corner of a
dialog box; then click the command or place you want
help with.

Choose Help � About Microsoft Access.

Exit Help Click the Close button at the upper-right corner of a
Help screen.

Version Number, System
Information, Technical Support
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Using the Help System and This Book
This book is designed to complement the Help system, not to replace it. Because the
online documentation does such a good job of showing you the steps for practically
any procedure you can perform in Access, and because many of those procedures
won’t interest everyone, we’ve taken a more conceptual approach here—one that
should help you work more creatively. Instead of presenting hundreds of little step-
by-step instructions (as the Help system does), this book deals with larger, more gen-
eral concepts so that you can see how (as well as when, why, and sometimes whether)
to apply the nitty-gritty details you’ll find in the Help system.

Looking Up Information
Like a book, the Access Help system has a table of contents, which is a great way to
learn how to do things. To get to the Help contents:

• Use the Office Assistant to open any Help topic, click the Show button if the left
pane of the Help window is not visible, and then click the Contents tab in the
Help dialog box.

Or

• If you’re already in a Help window and the Contents side of the Help window
isn’t visible, click the Show button on the left side of the Help toolbar. You’ll
return to the Contents, the Answer Wizard or Index tab, depending on what tab
you used last.

The Contents lists many options to explore. Figure 1.7 shows the Contents tab
with the Working with Data book selected. To open or close a book, click the Expand
or Collapse button before the book’s name, or just double-click the book. To display a
topic (preceded by a question mark icon, like this ?), click that topic. In Figure 1.8, you
see the Help window that opened after we expanded the Working with Data book and
then clicked the topic Repeat the value from the previous record.
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FIGURE 1.7
The Contents tab 

displays electronic
books filled with help

on many topics.
Double-click books 

to open or close 
them. Click topics to

display them.

Here are some tips for using a Help window (see Figure 1.8):

• To view Help text that’s hidden at the moment, use the vertical and hor-
izontal scroll bars as needed, or resize the Help window.

• To see the definition of a term or a button, click any text that’s under-
lined, or click a picture of a button. (Click anywhere inside or outside the defin-
ition, or press Esc to hide the definition again.)

• To print the current Help window, click the Print button on the Help win-
dow toolbar.

• To return to the previous Help window, click the Help window’s Back
button.

• To show the Help Contents if it’s not visible, click the Show button on the
Help window’s toolbar.

• To make the Help window reappear if it’s minimized or hidden, click the
Microsoft Access Help button on the Windows Taskbar. (The button name is
preceded by a small ? icon.)

• To close the Access Help window, make sure it’s the active window and
then click its Close button.
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FIGURE 1.8
A Help window that
shows information
about repeating a

value from the 
previous record.

Help with Whatever You’re Doing
When you’re not in a Help window, you can still get help by looking at the status bar,
preview areas, and any colored text on the screen for hints on what to do next. For
example, you’ll sometimes see a hint box on the object you’re working with and a
description of available shortcut keys in the status bar, as shown in Figure 1.9. (Though
that example won’t appear until you design a table, as discussed in Chapter 6.)

FIGURE 1.9
Hint boxes and the

status bar often pro-
vide further informa-

tion about what to 
do next.
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Searching Help
Like any good book, the Help system also has its own index. You can search the index
for help with just about any topic. Here’s how:

1. Go to the Help window as explained earlier in this chapter and then click the
Index tab. Figure 1.10 shows the Index tab’s contents after we typed wildcard
in the text box and clicked Search.

2. Type a word or select one from the list of topics. Search is not case sensitive. This
step highlights the closest match to your entry in the list(s) below the text box.

3. Click Display (or double-click a topic).

FIGURE 1.10
The Index tab after we

typed wildcard in the
text box.

Once the Help topic is shown on the right side of the Help window, you can use
any of the techniques described earlier to work with that information (see “Looking
Up Information”).
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Asking the Office Assistant
The Office Assistant enables you to search for information by typing in a few words. The
more specific your words are, the more on-target the suggested topics will be. But you
don’t have to worry about matching a topic name exactly because the Office Assistant
is pretty forgiving and even quite smart.

To use the Office Assistant, choose Help �Microsoft Access Help from the Access
menu bar, press F1, or click the Office Assistant button on the toolbar (see Figure 1.11).
(If you don’t see the Office Assistant after trying these options, choose Help � Show
Office Assistant and try again.) You can choose from several personalities for the assis-
tant. Just click the Options button in the yellow bubble for the assistant and click the
Gallery tab. Besides choosing the appearance of the assistant, you can change its
behavior. Click the Options tab in the Office Assistant dialog box, make your selec-
tions, and click OK.

FIGURE 1.11
The Office Assistant

showing Help topics on
customizing toolbars.
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To get help from the Office Assistant, first open the assistant if it’s not already visi-
ble on the Desktop. If you don’t see a yellow bubble with a Search button, click any-
where on the assistant, and then type a few words describing what you want to do in
the white box near the bottom of the yellow bubble and press Enter or click the
Search button. When the list of related topics appears, click the topic you’re inter-
ested in to open the corresponding Help entry.

In Figure 1.11, we typed customize toolbars and pressed Enter. The Office Assis-
tant ignores extraneous words, such as how do I fix, and focuses on the important key-
words, such as toolbar and customize. It then displays a list of topics that seem to
answer your question.

NOTE To hide the Office Assistant from view, right-click it and select Hide. It will reappear
when you click the Help button on the toolbar or select Help � Microsoft Access Help. To
deactivate the Office Assistant so you go directly to Help without it, right-click the Office
Assistant and choose Options; then, on the Options tab, uncheck Use the Office Assistant
and click OK. 

Getting Out of Help
You can get out of Help in many ways, but the easiest is simply to make sure the Help
window is active and then click its Close button. Click the window or its Taskbar but-
ton, if you need to.

NOTE In addition to the online Help described in this chapter, Microsoft offers many
other sources of help for Microsoft Access, Microsoft Office, and other Microsoft products.
See Chapter 4 for information about these additional resources.

Exiting Microsoft Access
When you’re done using Access, you should return to Windows before shutting down
and turning off your computer. You can exit from Microsoft Access using the tech-
niques you’d use with other Windows programs:

1. Go to the Database window or to the main Microsoft Access window.
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2. Choose File � Exit, click the Close button in the upper-right corner of the
Microsoft Access window, or press Alt+F4.

You’ll be returned to Windows or to another open program window.

TIP To exit Access when the Access window is minimized, right-click the Microsoft
Access button on the Windows Taskbar and then choose Close.

Where to Go from Here
Where you go from here depends on your past database experience.

• If you’re new to Access and to databases, continue with Chapters 2 and 3.

• If you’re new to Access but know something about databases, try the
hands-on guided tour in Chapter 3.

• If you’d like to see another view of what’s new, open the Office Assis-
tant, enter What’s New, and click a What’s New topic.

Where to Go from Here
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